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Today’s speaker

Member, Intuit Trainer Writer Network
Certified Professional Bookkeeper, IPBC
Insightful Accountant Top 100 ProAdvisor 2018

Mom of Gabriel, fiancé of Steve

Background in media production

Marnie Stretch, CPB | love to kayak, travel, and dance; I’'m learning French
Owner, Accounting Loft




Learning objectives

Discover what’s new in QuickBooks Desktop 2018

How these new features help you and your clients work smarter and
achieve better results

How these new features replace previous workarounds
Take a second look at QuickBooks Enterprise (QBES)
Time permitting — vacation hacks!




Agenda

Stay logged in

Merge duplicate vendors

Multi-monitor mode

More secure webmall

Search in chart of accounts
« Cash/Accrual toggle on Reports
« Past Due stamp on Invoices

* New keyboard shortcuts




Stay logged In

All QuickBooks Desktop, Pro & Up



2018: Stay logged In

Log into a file or switch to another file without having to
enter a username and password every time

Just every few days

Only if you’ve explicitly logged off from company file or
when the login period has expired

As long as you’re using the same Windows user account




Stay logged in — Turning on this preference

Not on by default

Option is enabled by a Company Preference:
- Enabled by the Admin user
- Applies to all users

Admin decides what the period of login is, from 1 day
up to 90 days




Stay logged in — General company preferences

B Accounting A My Preferences Company Preferences “
Bills a

il cance Stay logged in

B2 chequing Show portions of an hour as Help

% Desktop View © Decimal (10.20) Defaut « Available in Pro and up
k.| Finance Charge ® Migutes (10:12)

mpr— Also See: « General preference

SH  \ntsorated Application « Always show vears as 4 digits (1999) Reminders

& Rems & Inventory Mever gpdale_name Infnrma.tnc!n when saving transactions ° Company prefe rence

% Jobs & Estimates « Save fransactions before printing Py | - tt ”

manage login settings

@ Mutiple Currencies

B Poyments WANAGE LOGIN SETTINGS « Therefore is set by admin
Ef Payrol & Employees ) Log off every time a user closes the company or exits QuickBooks. :

© somodes o o v g o user and applies to all users
Al Reports & Graphs . for this company file

By saes 8 Customers 1Day 4, user will be automatically logged of. ¥ Learn more

e | .

P searen 7 Days

a Send Forms 30 Da'!fs

& Service Connection 60 Days

B spemng 90 Days

v




Stay Logged in — Various Access points for admin to turn it on

Pro/Premier/Accountant:
« Edit > Preferences > General > Company Preferences > Manage Login Settings or
« Company > Setup Users and Passwords > Manage Login Settings

QBES:
« Edit > Preferences > General > Company Preferences > Manage Login Settings  or
« Company > Users > Manage Login Settings




Once the “Stay logged in” preference is enabled

Emgdit View Lists Favourites Accountant Con
New entry point for logging off:

Mew Company from Existing Company File. ..

* File > Log Off from Company QOpen or Restore Company... |
Open Previous Campany k
Open Second Company |
. Create Backup...
N Ote . Restore Previous Local Backup k |
« The File > Close Company function will only close the rese om

Close Company

Company File but not logoff that user | Log Off from Company

Switch to Multi-user Mode
Litilities k

Send Company File 3

Print Invaice. .. Ctrl+P
Save as PDF...

Print Eorms [
Frinter Setup...

Send Forms...

Toggle to Another Edition...
Exit Alt+F4




Merge duplicate vendors

QuickBooks Accountant Desktop & all QBES editions



2018: Merge Duplicate vendors via client data review

QB Accountant Desktop & QBES
Not in Multicurrency files

Easily identify duplicate vendors
Merge 4 vendors at a time
Choose primary vendor

Retain important data present in duplicate vendors




Previous years: “Old school” merge vendors 2 at a time

Vendor Centre: Daniel's

Mew Vendor.. ¥ | New Transactions ¥ () Print ¥ Excel ¥ [ word

Vendors V d | f m t 0 &
en Or n Or a Ion r NOTE
Active Vendors - Edit Vendor ,
Mo note availabl
venDor wave Dan's Auto Emporium
REPORTS FOR1
NAME How do | adjustthe current balance? currency Canadian Dollar -

QuickReport
Accounting Cycle

prany NaME | Daniel's Open Balance
. FPANY NAME
Andre's Mechanical

r Daniel

Bank of Royals

Barata's Fine Wines
Blitz Marketing

¥ Qui ;
E% QuickBook:

Sales Tax Settings Supplies: L

Children's Charities 0 Account Settings ready being used. Would you like to merge them?
Craig's Lists of Stuff 0
Dan's Auto Emporium 0 HIETEIE T Yes
Daniel's CAD 0 213112024
Dobson's Properties  CAD 0
ADDRESS DETAILS
Fisher Supplies CAD 0 oen Fro et o
Gunes's Marketing CAD 0. Fiscal Year™.
Danigl's & &
Insurance Expers CAD 0. Salmonier Line
Jeanne's Compu-Exc.. CAD 0 Montreal, QC Copy ==
H2511G
Jesse’s Convenience... CAD 0
Kevin Anderson Barri... CAD 0
Minister of Finance CAD 0
Minister of Finance (... |CAD 0
Ministére du Revenu  CAD 0

: Vendoar is inactive “ Cancel Help
Receiver General CAD 0.

Rick's Office Superst.. CNY 0.00
Rogers and Compan... CAD 900.00




2018: Merge vendors up to 4 at atime

File Edit View Lists Favourites BGEOIEGS Company Sales Tay Customers Vendors Employees Banking Repors Window Help

Accountant Centre

Chart of Accounts Cirl+A
Fixed Asset ltem List

« Accountant & Enterprise Accountant:

Batch Enter Transactions..
Batch Delete/NVoid Transactions...

Accountant > Client Data Review >
Merge Vendors

Client Data Review

Make General Journal Entries. .
Send General Journal Entries...
Reconcile

Working Trial Balance

Set Closing Date...

Reclassify Transactions

Fix Unapplied Customer Payments and Credits
Clear Up Undeposited Funds Account

‘Write Off Invoices

Fix Unapplied Vendor Payments and Credits
QuickBooks File Manager Compare Balance Sheet and Inventory |
QuickBooks Deskiop Statement Writer

My Shortcuts

Troubleshoot Inventory
Find Incorrectly Paid Payroll Liabilities
Merge Viendors

Select Vendors

You can select upto 4 vendors to merge
Note: Vendors with online transactions, vendors with direct depesits and federal/state tax agencies are not eligible for merging. These vendors are not listed here.

. N O n _AC C O u n ta n t E n te r r I S e e d I t I O n S " VENDOR NAME & BALANCE TOTAL COMPANY NAME MAIN PHONE BILLED FROM ACCOUNT NO. BUSINESS NUMBER
" Accounting Cycle 0.00 Accounting Cycle 780 628-2405 #102 11302-119 St =

Andre's Mechanical 0.00 Andre’s Mechanical 604 999-9998 Andre’s Mechanical

(S I g n e d I n aS Ad m I n O r EXte r n al ACCt u S e r) B. Bron Barrister and Solicitor 0.00 B. Bron Barrister and Solicitor 909 809-0900 B. Bron Barrister and Solicitor
Bank of Royals 0.00 Bank of Royals
Barata's Fine Wines 0.00 Barala's Fine Wines 809 809-7777 Barata's Fine Wines
Bliz Marketing 2,131.18 Blitz Cleaning 555-5555 Blitz Marketing
Craig's Lists of Stuff 0.00 Craig's Lists of Stuff 222 222-2622 Craig's Lists of Stuff
Com pany > Accountant Tools > M erge
Dan's Auto Emporium 0.00 Dan's Auto Emporium 6136136131 Dan's Auto Emporium
vend I L L S Y S e I R
e n O r S Fisher Supplies 0.00 Fisher Supplies 212 1122121 Fisher Supplies
Gunes's Markefing 0.00 Gunes's Markefing 613 316-1116 ‘Gunes's Marketing
Jeanne's Compu-Excellence  0.00 Jeanne's Compu-Excellence Jeanne's Compu-Excellence
acen's Canuoniance Stars 0 0N laces's Canvanianca Stara ANA ANR-1111 lazeas Cnnuanionra Stora |

3 = Inactive Vendor




2018: Select A master vendor to merge and copy data

Merge Vendors

Select a Master Vendor

Yote: The transactions of other vendors will merge with the master vendor. The Vendor Information, Notes, Contacts, To Do's, and Sent Email List information will not get merged. You can update the master vendor with information that you want to carry over from the other vendors.

(O Craig's Lists of Stuff @ Daniel's (O Dan's Auto Emporium () Dobson's Properties
VENDOR 15 ACTIVE Yes Yes Yes Yes
BALANCE TOTAL 0.00 0.00 0.00 0.00
MNO. OF TRANSACTIONS IN 0 0 0 0
LAST 2 YEARS
MOST RECENT TRANSACTION
DATE 17272026 121172026
OLDEST TRANSACTION DATE 17272026 11372026
COMPANY NAME Craig's Lists of Stuff Daniel's Dan's Auto Emporium Dobson's Properties
EILLED FROM Craig's Lists of Stuff Daniel's Dan's Auto Emporium Dobson's Properties
6 Cudmore Ln. Salmonier Line 320 Croydon Ave. 4202 England Road
Ottawa, ON Montreal, QC Ottawa, ON Ottawa, ON
K2H 3J4 H25 L1G K5J 6T5 K3K 2K3
MAIN PHONE 222 222-2622 ‘ 514 §78-8787 | 613 613-6131 859-8595

ACCOUNT NO. ‘ |

Previous Merge Backup & Merge




Multi-monitor mode

All QuickBooks Desktop, Pro & Up



Previous years: Manually stretch the QuickBooks window

Sample Premi Q op: untant Edition

Accountant Company Sales Tax Customers Vendors Employees Banking Reports Window Help

VENDORS

— ®

Purchase Receive Enter Bills

Hey, I'm dragging the
window edge to
stretch it into the

next monitor!

Reminders

Memorized Reports

My Shortcuts

Reminders + o

7 @ROUP [Accountant

Today, Monday 04, September 2017 Upcoming al Ledger

B TO DO NOTES({6) B TODONOTES (6) Loss
ce Sheet

fal Entries Entered/Modified Today

» OVERDUE INVOICES { 141) 48933 81 B MONEY TO DEPOSIT () 12,037.64

B SALES ORDERS TOFPRINT (3} 948126
B BILLSTOPAY (T) -3,705.01 M

b CHEQUESTOPRINT (13}

-33,477.06

Accountant Updates

P INVOICES/CREDIT MEMOS TO PRINT ( 119 ) 20,835.96

P PAY CHEQUESTOPRINT (5] -17,272.68

B PURCHASE ORDERS TO PRINT (3}

-31.90555




2018: Switch to multiple monitor display up to 3 monitors

ab

Sample Premier Hockey School - QuickB Premier Accountant Edition 2018

File Edit BUETN Lists Favourites Accountant Company Sales Tax Customers Vendors Employees Banking Reports Window Help

3 Open Window List
Switch to Multi-maonitor Mode

Top Icon Bar
v Left lcon Bar
Hide lcon Bar

Customize lcon Bar..
Add Window to lcon Bar...

v Favourites Menu

One Window
v Multiple Windows

y Shortcuts

Time Saving Tip (|
Cirl+Alt+M

Move Windows Between Monitors, Easily.

Click "Move Window to Mext Monitor” to move a window to your next monitor. It's
convenient, easy and requires no dragging. You can also press Ctrl + Alt + N to move
windows effortlessly.

Move Window to Next Monitor button > Eﬂ

COMPANY

Chart of
% Accounts

Sy Bille =




2018: After switching to multiple monitor display

« Move Window to Next Monitor icon

Em 3 Yow Lats Facuites Accourtant Company Sales Tag Cystomers Vesdan Emciopess Qanting Bepdts  fiodow L

posasoncs CAD 114,196...
“TO0VN% W
ESow

LONL W ACD0WNE Al I o
[“ssn] e

PIO0S @ T DOV B WowOsenge TR oW - Sotly Ovtest

Premier Hockey Schost
Profit & Loss

Ui wdae JON




More secure webmall

All QuickBooks Desktop, Pro & Up



2018: More Secure webmalil
(Gmail/Outlook/Hotmail/MSN/Windows Live)

Enable QBDT users to send webmails in line with
contemporary security standards

Secure webmail through QuickBooks using improved multi-
factor authentication

QBDT seamlessly sends emails until the customer revokes
the permissions (no password required each time)




2018: More secure webmall

Edit > Preferences > Send Forms > My Preferences > Webmail >
Add > Use enhanced security

emartng - ang
T Come
amras L (Pa 3 on . " 1 -
w
BT
"

:: -

Canmscmn

« Use enhanced security (Recommended) Sign in

vEFECiFgrYFEYEIIRAY
ERERE

H | B
£
-

Teife o Wl SeORman (Waled PRXrTor Wit Te Securwh
el o) JuciBbocs

L man
— - Your Emed or Intuit User 1D

i




Search In chart of accounts

All QuickBooks Desktop, Pro & Up



2018: Search in Chart of Accounts

“Within” text search even if you don’t know exact
account name or how name starts

Looks through key account identifiers: name and
number

Works very much like Search field in Item List




Previous years: Looking for an account

MAME P g TYPE ! CURRENCY

+ 6900 - Bank Fees Expense CAD =
+5905 - Interest Expense CAD
+B910 - Senvice Charges Expense CAD

+ 6200 - Freight/Shipping Expense CAD

s EEIZ(J - Insurance Expense CAD
¢E§5 - Liability Insurance Expense CAD

+ 6560 - Payroll Expenses Expense CAD

+ 6683 - Professional Fees Expense CAD
+B650 - Accounting Expense CAD
+B655 - Legal Expense CAD

+ 6250 - PST Expenses Expense CAD

+ 6500 - Rent Expense CAD

+ 6950 - Sales Discounts Expense CAD

+ 6770 - Supplies Expense CAD
+B780 - Marketing Expense CAD
+G790 - Office Expense CAD

+ G820 - Taxes Expense CAD
+B6830 - Federal Expense CAD
46 - Provincial Expense CAD

+ G600 - Utilities Expense CAD
+B605 - Electricity Expense CAD
+B610 - Phone Expense CAD

+ 6300 - Vehicles Expense CAD
+B6310 - Fuel Expense CAD
+B320 - Maintenance and Repairs Expense CAD

+ 6955 - Vendor Discounts Expense CAD

+ 90200 - Sales Orders MNaon-Posting CAD

+ 2 - Purchase Orders MNon-Posting CAD !I
Account ¥  Activities ¥ | Reporis ¥ | Attach Include inactive




2018: Search on any part of account name or number

Look for account name or number

@

NAME

+ 1489 -
+ 1800 -
+ 1800 -
+ 1800 -
+ 1800 -
+ 1800 -
+ 1800 -
« 2240 -
+ 2400 -

| @ Reset

Property Plant & Equipment:1840-0 - Computer Equipment

Undeposited Funds

Property Plant & Equipment.1840-0 - Computer Equipment;1840-99 - Accum. Amaont.

Property Plant & Equipment.1840-0 - Computer Equipment.Cost

Property Plant & Equipment:1845-0 - Computer Software

Property Plant & Equipment: 1845-0 - Computer Software:1845-99 - Accum. Amort.
Property Plant & Equipment:1845-0 - Computer Software:Cost

PST Payable

Term Loan

+ 49900 - Uncategorized Income

+ 4010 -
« G420 -
« G420 -
+ G645 -
+ G645 -
+ BA45 -
« BB20 -

Sales

Insurance

Insurance: 6425 - Liability Insurance
Professional Fees

Professional Fees:6650 - Accounting
Professional Fees:6655 - Legal

Taxes:6840 - Provincial

+ 4 - Estimates

i€ I TYPE

Other Current Asset
Fixed Asset

Fixed Asset

Fixed Asset

Fixed Asset

Fixed Asset

Fixed Asset

Other Current Liability
Long Term Liability
Income

Income

Expense

Expense

Expense

Expense

Expense

Expense

Mon-Posting

| CURREMNCY i BALANCE TOTAL

CAD 5,940.0C
CAD 0.oc
CAD 5,940.0C
CAD 832.0C
CAD 0.0c
CAD 832.0C
CAD 2,658.31
CAD 96,150.0C
CAD
CAD
CAD
CAD
CAD
CAD
CAD
CAD
CAD



Cash/Accrual toggle on
Reports

All QuickBooks Desktop, Pro & Up




Previous years: Cash vs. accrual basis not easy to switch

Profit & Loss
Customize Report Comment on Report Memorize Print | E-mail ~ | Excel ¥ Hide Header | Expand Refresh
Dates\ * | From B 1o B showColumns Total only * SortBy Default L
Show | Appli i
1:02 PM .
Modify Report: Profit & Loss
12/31/24 =
Accrual Basis Display Eilters Header/Footer Fonts & Numbers
REPORT DATE RANGE
I
Dates All * | All dates in your company file
From B 1o -
REPORT BASIS
n
G \’"‘ Accrual "T‘} This setting determines how this report calculates income and expenses.
o
H COLUMNS
Display columns by Total @ = across the top. Sortby  Default -
cort @ Ascending order 2%
ortin
~ . z
Add subcolumns for Descending order &4
Frevious Period Frevious Yiead Year-To-Date % of Row % of Column
CAD Change CAD Change % of YTD
% of Income % of Expense
% Change % Change
Advanced... Revert
T
Net |
eting Cancel Help




2018: One-click Cash/Accrual toggle ... means you don’t have to dig

2018: One-click Cash/Accrual toggle means you don’t have to dig

= [Die Eon Yww QUECE Fromes Accounitend Coemgany Cysbomaes  vendprs  Emplopses  Banking Ewpir fiindow Help Del

CusboTye e g COaTaTeEfIL Of R 1 1 i Prinj = Emafl ~ Egcel « Hide Hegder  Collagse Roafeogh

ates M = Fiom BT B Show Cobemgs  Tolal only = Soaly Detaul

Rpon Dat: = ASerun Cah S IFiftiers
dei T P o Tas
Profit & Loss
[ A1l Transactions
 Cw ey income Eupende
INECOHTHY
s winie] i [ a7 A

Folal Irscosrie T

lllllllll T
bl =7 .
Automobile Expe 1,503 28 ‘#
[e-fe? &4 Loy el i1 z
rrrrrrrrrr T E
nnnnnnnnnnn " £

|||||||||| T
*




"Past Due” stamp on Invoices

All QuickBooks Desktop, Pro & Up



Previous years: Overdue invoices were handled this way:

SELECTED TEMPLATE
PAST DUE Invoice

Header

Default Title
Date

Invoice Number
Invoice To

Ship To

PO No

3.0 Na

Terms

Due Date

REP

Account Number
Ship Date

Ship Via

FOB
Projectilob
Other
Customer Bus #

Spouse's Name

Help

Columns

Screen

DD DRARDRA®

Prag Cols

Print

=

=

]

I D D @ DD D0 DR D0D@®D®

‘When should | check Screen or Print?

Faoter

Title
Invoice
Date
Invoice #
Invoice To
Ship To
P.O. No.
Phone #
Terms
Due Date
Rep
Subtotal
Ship Date
Ship Via
F.OB.
Froject

Customer BN

Print

Default

Invoice

PAST DUE
—

Tetal ..

Layout Designer...

o

Print Preview...

Cancel

Main
@

Find

Formatting

B E % CreateaCopy 0

New Save Delete aMemorize

Send

Reports

E = Print Later
Mark As Print  Email Email Later
Pending T T

0

Attach

File

B Add Time/Costs
&3 Apply Credits

(]} Create a Batch

Receive B Refund/Credit
Payments

S PAST DUE Invoice

Fixed Fee Invoice

DATE Intuit Packing Slip
1210472024 Intuit Product Invoice
INVOICE # Intuit Professional Invoice
281 Intuit Service Invoice

Intuit Standard Pledge

Invoice from Proposal 4S5

Lawyers's Invoice 10 Net 30
ITEM Lary i DESCRIPTION i TAX
Pro Wor... & Special Order Progress Invoice 00s

Property Management Charges

Property Management Invoice

Rent Invoice

Tenant Charges

Time & Expense Invoice E

SUNRER T PSP SHLES B 5000

CUSTOMER MESSAGE TOTAL 847 50
\We appreciate your prompt . FAYWENTS AFFLIED 0.00
payment. BALANGE DUE 847.50
MEMO Save & Close Revert

-

>
=)

«
l{i‘
=

=]

)
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-
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Y

NS

RS

=

-
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2018: Setting up for p

SELECTED TEMPLATE PREVIEW
Copy 4 : Intuit Product Invoice

Manage Templates...

LOGO & FONTS 4467 Diven
Torcaso O M4Y 208

Uselogo Select Logo...

Select Colour Scheme

Please Select.. = Apply Colour Scheme

Change Font For.

Title

Change Font... T

A

l T | = [ o= [ ==
Company Name [ [ [ | [ [
CompanyAddress omtn [~ [— [ ot
Labels

v

COMPANY & TRAN SACTION INFORMATION

| Company Name Phone Number

Update Information... /
/

w| Company Address E-mail Address

Fax Number Web Site Address

¥ CRABusiness No. MRQ QST Registration No.

T ax Summan
Mark taxable amounts with “T" when prinf

sutota cxan

Saies Tan Total

Total cxnnm

Select only when you wantto include Past Due information Stamp.

[
Print Status Stamp

Selectto include the status on the form. Various statuses are, Paid, Pending,

Received, Void, and so on

How do | apply a design across multiple forms?

Help Additional Customization... Layout Designer...

Print Preview...

Cancel

ast due stamp on invoices

= Eile Edit Wiew Lists Favorites Accountant Company Customers Vendors

Main Formatting Send/Ship Reports

«» B B &

Find Mew Save Delete QMemurize

| Print Later

Create a Copy ° E =

| Email Later Attach

Employees Banking Reports Window Help Beta

@ @

App Center A oll Credit Cards

Create a Batch

0 B 2dd Time/Costs &

& Apply Credits Receive B Refund/Credit
File Payments

I H BILLTO
nvoice O]
PASTDUE
v ible on print & email for this invoice 4
TERMS DUE DATE
~ 031222017 B
ITEM aTty RATE
Reimb Subt =
TestSenice 327.00 TesiClass 327.00
v
*Your customer can't pay this invoice online
Turn on 327.00
CUSTOMER ME PAYMENTS 0.00
- BALANCE DUE 327.00
HENO Save & Close Revert

Customer

SUMMARY
Email chetnasamant@gmail.com
Preferred delivery method E-mail
Open balance 7T4.00
Active estimates 0
Sales Orders to be invoiced B
=
w
=
B
‘CUSTOMER PAYMENT ‘ §
Your customer can not pay onling =
Edit customer preferences E
RECENT TRANSACTION %
0312317 Invoice 200.00
03/22H7 Invoice 327.00
HOTES @




New keyboard shortcuts

All QuickBooks Desktop, Pro & Up



Previously: Copy line and paste line using right-click or edit menu

ces - Accounts Receivable

Main Formatting Send Reports oA
«» B BH X Create aCopy Q) G (& [ Pontiater M &bado Tmercosts B &P RefundiCredit
Find New  Save Delete a Memorize Mark As Print  Email Email Later Attach % Apply Credits Receive
v v Pending T T File Payments

MER: JOB Ciaran,J... - e CLASS Peestad 1200 -Acc.. + ReSt=Ns- Intuit Senvic... =

Customer

Ders INVOICE TO
1011512024 L Cioran,Jason SUMMARY
: 57 River Avenue
INVOICE & ¥
Montreal, QC Phone 902-8020
271 HZE 9v3 Open balance 124.68

Credit Limit 25,000.00
F.O. NO. TERMS Active estimates 0
Due on receipt = Sales Orders to be invoiced 0

L @TY ! DESCRIFTION ! RATE ! CLASS §AMOUNT | TAX
“ees 75.00 = Schoolindiv. Consult - 75.00 G+ | &

Undo Typing

Cut RECENT TRANSACTION

Co
. ptl" v | 12115/24 Invoice
asie
E 10115424 Payment
SalectAll SUMMARY GET FOR SALES 5.0% cAD 3.75 10/15424 Invoice

09/15/24 Invoice - Paid

CUSTOMERIM  pacts Line TOTAL  CcAD 7875 081524 Invoice - Paid
Thankyou! InsertLine ,:_, PAYMENTS A4PPLIED  CAD 6.25
Delete Line secance oue CAD 72.50

MEMO Save & Close Revert




2018: New keyboard shortcuts to copy and paste entire rows

Copy row = Ctrl-Alt-Y (from any position)

Paste row = Ctrl-Alt-V (from any position)

Works with:

* |[nvoices * Credit Memos

« Estimates * Purchase Orders
« Sales Receipts * Timesheets

e Sales Orders




Inventory Report Customization

All QuickBooks Desktop except Pro



Previous years: No customizing columns in inventory
reports

Modify Report: Inventory Valuation Summary

Display Eilters HeaderFooter Fonts & Mumbers
REPORT DATE RANGE

BEI Ll This Month-to-date - From the first day of the current month through today

From |12/01/2024 B To 12/31/2024

No Customization of
Columns!

Revert




2018: Customizing columns in inventory reports

Modify Report: Inventory Valuation Summary

Display Filters Header/Footer Fonts & Mumbers

REFORT DATE RANGE

i1 This Month-to-data

- From the first day of the current month through today

From |12/01/2026 @ To 12/312026 [

COLUMNS

Com b (™ -
Search Columns

.
-

< %% of Tot Retail
Order
SalesMeek
On Sales Order

.,

Available
ForAssemblies

Reorder Qty
Put a check mark next to each column

v that you wantto appearin the report. Revert




2018: Inventory report customization

Add Columns in Inventory summary reports
 |nventory valuation summary — 17 fields added

 Stock status by item — 15 fields added
« Assembly shortage by item — 11 fields added (QBES only)




Another look at QuickBooks
Enterprise Solutions




Why Enterprise? Same look & feel but...

Up to 30 concurrent users

More granular security (100+ vs. 15 “chunky” levels)
Handles larger data files

Open 2 companies @ once

Combined reporting

Faster




Why Enterprise? Same look & feel but...

Larger list limitations (e.g. 1 MM items vs 14,500)
Easy to migrate
Payroll & unlimited Canada-based tech support

Additional features such as sorting a form by the column
header, disallow negative inventory, suppress footer on
every page but the last one on multi-page invoices




Why Enterprise? Same look & feel but...

Customer resource centre website

< (&] | & Secure |https:.’}'qu\ckbooks.intuit.ca,*'cu\ckbooks—en'.erpr\se-soft\-u'are.’e»-ery‘lhing-Enter;:r\se,f'.-\felcome.jsp
Esther's companies @ Employees @ Invoice @ Expense @ Deposit J[, 30 Websites That W @ Test Drive QBO Canz @ QBO Test Drive [

ca w0
» Other bookmarks

i Apps @ Chart of Accounts

Intuite QuickBooks® Enterprise M Geneits | Suppoit | Training

Everything Enterprise.

& @ Everything you need + even more

O

/}" Launchpad.
’ j Installation starts here. Choose the

path that best describes you.

m Installing QuickBooks for the first
time =

o Upgrading f

QuickBooks -
S, Ve f
Updating a o ", | 0 J,.' *
Qb of QuickBoc -_— S -
QuickBooks Canadian- Unlimited calls Payroll &
Enterprise based product to technical Employes-

upgrades expert advice support Tracking Tools

Data recovery
service

P |
I\\iﬂ%;

In-depth online
training



Why Enterprise? Same look & feel but...

Automatic product upgrades
Industry Flavours
Advanced Inventory

Advanced Pricing




Why Enterprise? Same look & feel but...

Hosting Services: Toronto-based data centre, automatic
backups, bank-level security, complimentary support

@ quickbooks

QuickBooks Enterprise
Cloud Hosting Service

Run your QuickBooks Enterprise from the cloud

(866) 9357237

[ Contact Sales

Or...Terminal Services supported




Time permitting

Vacation hacks!




Questions?




ab quirckbooks.




